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inally, we did it. You are reading the first issue of a magazine enterily
dedicated to BeOS and other "alternative" operating systems. What do
we mean by "alternative"? We won't deny the facts. Microsoft Windows is

surely not, absolutely the best OS yet well spread and supported. In a scene
dominated by the products of Microsoft, a few others try to cut out a space in
the market. Apple suffers though its good Mac OSX is better than Windows. But
there is a precise reason: it is compatible with PowerMacs only, objectively less
spread than Intel platforms. What about the others? Linux has no real market,
but it's holding its own and it's been successful so far along with FreeBSD.
Though the demise of Be, BeOS seems to rise again like a Phoenix from its ashes
thanks to OBOS, Cosmoe and the other Open Source related projects. If it's
true that an open source OS can meet success on the other hand a good mar-
ket policy can grant even greater successes. Here's YellowTab entering the
scene, the heir to Be is going to put Zeta on the market.
Even AmigaOS didn't remain behind, the fourth version of this historical OS is a
turning point and it's ready to attack the market with a product which comes
up to the expectations and that supports 
up-to-date hardware at last.
That are in our opinion the alternative systems.
We would like to give you a great deal of informationsa and make a comple-
te and precise service.
We sincerely hope that you will appreciate our work.
In this first issue we will introduce Zeta, you will find a very interesting tutorial
about Rebol language (by Carl Sassenrath, the author of Exec, the kernel of
AmigaOS!) and a service on the games we played during this hot summer. The
special section EmuZone is dedicated to Prince of Persia and the MSX.
Finally the reportage about the Italian meeting Amiga Alpe Adria 2003 and the
news.
Have a nice reading!

Gian Davide Alfano
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by Andrea Bernardi [atomozero@libero.it]

BeGeistert website confirms the dates for the most
important european BeOS users meeting.
On october 18-19 2003 it will take place the ele-
venth BeGeistert edition, in Dusseldorf as always,
but in the the new place, the hostel of the Youth,
which should be able to receive all the parteci-
pants.
Should, because people attending the manife-
station became more numerous each year, and
they came from every part of Europe, Italy inclu-
ded!

http://www.begeistert.org/

Sum Software rilascia Becasso 2.3

It was in the far 1999 that Sum Software didn't release any upgrade for this graphic application.
Becasso has been the first commercial graphic application for BeOS.
This new version sports a better support for scripts, using which one can control filters and their parame-
ters.

http://www.sumware.demon.nl/

The soap-opera goes on...

It is some time, now, that SCO finds itself in the
middle of legal suit, pretending having been
damaged by the violation of some of its copyright.
SCO says that part of the linux kernel code has
been copied from Unix, of which the relative
copyrights are in its possession.
Obviously SuSE and RedHat send back those pleas
saying that are threats devoided of any funda-
ment.
According to the two, SCO requests (that asks
linux users to pay for a UnixWare license to be
legit) are also absurd.

T2 bests many aspects of T model: first it has a
more stylish design, with a completely silver case,
mantaining the flip opening.
The first news is the display.
It's the same display has seen on Palm Zire 71, i.e.
65k colors TFT, transflective touch screen with a
320x320 pixels resolution.
Processor is a Texas Instruments OMAP 1510 ARM,
144 mhz, with 32 MB ramand 8 MB ROM.
The operative system is Palm OS 5.2.1.
Among the new features are the possibility to play
MP3 and movies fo various kind, also in streaming
video thanks to the integrated RealOne Player.
Tungsten T2 will have also the software Documents
To Go, which will let it read and edit Microsoft
Office files.

http://www.palm.com/

Palm Tungsten T2



Apple confirms: 
Panther is not a 64-bit OS

Panther will not be a full 64-bit OS.
The news comes straight from Greg
Joswiak, Apple hardware products
manager, on many internet websi-
tes.
But this means not by all means that

Panther will not be able to gain from the use of
PPC 970 processors.
Apple choice will have a great benefit from all
fronts.
Users will not be obliged to upgrade all their appli-
cations to 64-bit versions, just to see them run the
new machines and developers also will not need
to upgrade their applications to see them using
the new speed in mhz of the PPC 970 and the
new G5 architecture.

http://www.apple.com/it/
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At the end of july EarthSoft will release in
Japan a video acquisition card compatible
with BeOS.
The product, known with the name of PV1, will
be given with the SDK for BeOS, letting deve-
lopers create their own applications.
The card is interesting, because it will be pos-
sible to acquire in DV format from analogic
sources, and the encoding, just as the deco-
ding, will be supported by the hardware, and
not by the CPU.
On a sad note, it seems that the product will
be availabe only for the japanese market.

http://earthsoft.jp/

EarthSoft releases an acquisition card BeOS compatible

Novell NerWare 6.2 soon to be released
Novell has officially announced the release of NetWare for middle august.
Next release of NetWare more important feature is the more compatibility with the linux platform.
Let's not forget that in the novell roadmap one of the most important targets is called "Linux migration".
The new versions of Novell Software will run on Linux platform, too.
Netware 6.5 is an integrated product, sporting application server features, web service features and of
course the classic NetWAre services.

http://www.novell.com

The Rack is Back
Rack747 is the best virtual groovebox for BeOS
and it's back, better than ever!
first of all, the new version is a demo no more but
a full one, the Midi management has been fixed,
with more filters and effects.

http://www.labyrinth.net.au/~dak/rack



by Andrea Scatena [andyscat@libero.it]

This is the new column for newbies. We will introduce you the Beos File System

BeOS filesystem

O
ne of the fundamental characteristic of an
operative system is the structure of its filesy-
stem.

In BeOs, the structure is typical of POSIX systems (it
is important to remember that BeOS is not a Unix
flavour, but an o.s. completely written from
scratch): so we have a primary directory from
where all the others sub-directories descend, and
in which  every component of the system and the
user's files and directories, are organized by cate-
gory.
The origin directory is /boot and it represent the
"root" of the system, the volume or partition from
which the system boots.
From /boot we have the following directories:

/boot/apps
/boot/beos
/boot/demos
/boot/develop
/boot/optional
/boot/home
/boot/preferences
/boot/tmp

Anyone is free to add whichever other directory
under /boot, but it is preferable that user-created
directories should be put under /boot/home.
That's because in BeOS there are two kind of direc-
tories: system directories and user-level directories.
Everything under /boot/beos is reserved to the
system, all else is free access for the normal user.
Be careful, though, because nothing stops you
from putting your hands in /boot/beos, but the
outcome could be an unusable system.
The reason is that BeOs, even if is a POSIX-com-
pliant system, doesn't inherit all its characteristic,
e.g. the multi-user environment: BeOS is not a
multi-usr system, although the great part of the
code is
quite implemented.
Whenever a multi-user environment will be imple-
mented, the conseguence is that the single user
would not be allowed to mess with the system
directories.
The matter of a multi-user environment is very
complex and involves the separation of the users
in groups, each of them with particular powers,
called privileges, that allow them to read, write
and execute files and directories (but this is some-
thing that we will see another time).
And now the division between /boot/beos and
/boot/home assume a precise meaning: to make
an example, we will find in /boot/beos/apps all
the system applications, so to be accessible to

every user; in /boot/home apps we will find only
the applications accessible to the user owner of
that /home directory, that are not executable by
the other users.
Multi-user implementation would imply that under
/boot/home one will find as many Home directo-
ries as the number of users of the machine on
which is installed BeOS, each with is distinctive
name.
Another thing that characterized the system is the
presence of invisible files and directories in the
Tracker, accessible only by the command line from
the Terminal app.
Invisibility comes from the fact that those directo-
ries and files are reserved for system functionality,
but that are of no use for the final user (for the
major part), or are potentially dangerous if messed
with.
These directories are accessible and editable only
in the Terminal app, using shell commands.
BeOS filesystem has something unique: it is build to
act as a database.
Every element in BeOS, both a file and a directory,
is recorded as an element of a database, with the
possibility to execute really complex searches on
the whole system.
THis kind of search is called "query" and can be
saved and visualized later in a Tracker window.
Queries are live, that means that they change in
real time whenever the elements that constitute
the query change.
For example, let's make a query to obtain the list of
the persons belonging to ItBug (BeOS Italian User
Group) that registered themselves between
december 2002 and april 2003 and visualize it in a
tracker window; let's suppose that we have left a
name outside of the list and let's do it now, leaving
the tracker window open: in the same moment
when we have completed the insertion, automati-
cally the name will appear among the others, with
no need to re-launch the query itself.
The possible applications of such a characteristic
are awesome and absolutely exclusive of this won-
derful operating system.
Obviously there is more deepness and complexity
in this matters, and we have done a ten thousand
feet bird-view, reserving for the future a deeper
look at those issues.                                               
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di Andrea Scatena [andyscat@libero.it]

This time we analyze the MacOSX filesystem

OSX
filesystem 

T
wo years are now passed since Apple has put
aside, de facto, Os 9 in favour of the next
generation of its operative system: Os X.

The X stands for 10 (like good old Steve Jobs says),
but also points to its Unix origins.
The jump from Os 9 to X it's a quantum one: this is
not an upgrade of the operative system, it is a
total rebuild, one that lays its foundation on a
micro-kernel, Mach, from BSD.
This decision was given birth in the moment in
which Steve Jobs returned to the company he
founded with the other Steve, Wozniak, bringing
his experience from NExTStep, an operative
system that was a
total commercial fiasco, but technologically
absolutely way ahead of its time.
Os X has had three primary incarnation, as of
today: 10, 10.1 and 10.2.
The very first version was not really usable, from a
professional point of view, but the next versions
were progressively polished, and the last incarna-
tion, 10.2.6 is an o.s. absolutely robust, stable and
productive.
And now version 10.3 is coming, code-name
Panther (you can see that Steve Jobs has a like-
ness for felins with Cougar, Puma, Jaguar and
now Panther), putting Apple o.s. a step ahead,
again.
But now we are putting aside the innovative
aspects of the Cupertino technology which we
are used to, and that characterized, more or less,
every release and upgrade of Apple's systems.
Just like the other article on BeOS filesystem, we
will try to analize Os X filesystem structure, to bet-
ter understand this o.s. that, in my humble opinion,
is, togheter with BeOS/Zeta, the edge for techno-
logy
and usability.
Differently from BeOS, written totally from scratch,
Os X is in all effects a Unix system (so that nowa-
days Apple is the first Unix systems company, with
an users base of more than two millions).
To analize the system structure we are using a litt-
le trick: open a terminal and type at the shell
prompt "man hier".
The output of this command (TABLE 1 of the next
page) gives us a syntetic description of the filesy-
stem
structure, along with a short description of the

directories ( a directory in unix is the equivalent of
a mac folder).

The /home directory is replaced by the /Users
directory in which we will find the various home
folders of the users created on the machine.
Also in this case, like in BeOS and in the others *nix
systems, the structure is absolutely logical and
coherent.
Os X is a multi-users environment, and this is reflec-
ted in the implementation of the users privileges
and in the complete separation of their areas of
use: every user has its home and nobody (except
the super-user, root) can manipulate its files and
folders (if you enter another home, the folders
within have a no-acces symbol at the bottom of
their icons).
As you can see, analizing the man hier output, we
find some directories that seems to repeat along
the system hierarchy: the /bin, /sbin and /tmp
directories.
It is of some interest to notice that both for /bin
and /sbin, when they are directly under root (/)
they contain programs, utilities and daemons that
"belong" to the system, while when under /usr
they
contain the programs and utilities that "belong" to
the single user.
Unlikewise from other *nix systems, Os X puts under
root (/) other folders too: Applications, Desktop,
Library, System, Users (of which we have talk
about before), Volumes and Developer (this one if
you
have installed Apple's developer tools).
I could go along for pages, but I prefer to  stop
here, hoping I was been sufficiently clear, enough
to let you want to know  some more.

With the next article I will go deeper inside those
folders, so see ya soon.
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[host1:~] user1% man hier
NAME

hier - layout of filesystems
DESCRIPTION

A sketch of the filesystem hierarchy.
/ root directory of the filesystem
/bin/ user utilities fundamental to both single-user and multi-user environments
/dev/ block and character device files

fd/  file descriptor files; see fd(4)
/etc/ system configuration files and scripts
/mach_kernel kernel executable (the operating system loaded into memory at boot time).
/sbin/ system programs and administration utilities fundamental to both single-user and 

multi-user environments
/tmp/ temporary files
/usr/ contains the majority of user utilities and applications

bin/ common utilities, programming tools, and applications
include/ standard C include files

arpa/ C include files for Internet service protocols
hfs/ C include files for HFS
machine/ machine specific C include files
net/ misc network C include files
netinet/ C include files for Internet standard protocols; see inet(4)
nfs/ C include files for NFS (Network File System)
objc/ C include files for Objective-C
protocols/ C include files for Berkeley service protocols
sys/ system C include files (kernel data structures)
ufs/ C include files for UFS

lib/ archive libraries
libexec/ system daemons & system utilities (executed by other programs)
local/ executables, libraries, etc. not included by the basic operating system
sbin/ system daemons & system utilities (executed by users)
share/ architecture-independent data files

calendar/ a variety of pre-fab calendar files; see calendar(1)
dict/ word lists; see look(1)

web2 words from Webster's 2nd International
words common words

man/ manual pages
misc/ misc system-wide ascii text files
mk/ templates for make; see make(1)
skel/ example . (dot) files for new accounts
tabset/ tab description files for a variety of terminals; used in the 

termcap file; see termcap(5)
zoneinfo/ timezone configuration information; see tzfile(5)

/var/ multi-purpose log, temporary, transient, and spool files
at/ timed command scheduling files; see at(1)
backups/ misc. backup files
db/ misc. automatically generated system-specific database files
log/ misc. system log files

wtmp login/logout log; see wtmp(5)
mail/ user mailbox files
run/ system information files describing various info about system since it 

was booted
utmp database of current users; see utmp(5)

rwho/ rwho data files; see rwhod(8), rwho(1), and ruptime(1)
spool/ misc. printer and mail system spooling directories

mqueue/ undelivered mail queue; see sendmail(8)
tmp/ temporary files that are kept between system reboots

TABELLA 1

OSX filesystem
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by Giuseppe Gargaro [giuseppe.gargaro@tiscali.it]

A
DSL (Asymmetric Digital Subscriber Line) is a
technology that transforms a traditional
phone line in a digital connection line used for

data trasnfert.
It uses the ordinary phone cable and permits to
carry an elevated frequency signal for data-tran-
sfer, simultaneously with the signal used to carry
the voice.
ADSL is a high-speed connection in asimmetric
mode: that is, upload speed and download
speed are not the same.
This way,  the typical web surfer gains the most
from the receiving end of the connection, while
loosing something in the sending.
Speed differs based on the contract signed with
the provider of the service, varying from 256 kbit
per second to 1.2 mbit per second in download,
and from  128 to 256 kbit in upload.

Now, let's see what's needed in BeOS to use ADSL:

driver PPPoE for BeOS: www.bebits.com/app/1707;
a network ADSL modem and an Ethernet card

BeOS compatible (e.g. a

RealTek one);
a subscription with an ADSL provider.

NetServer configuration under BeOS 5

Now, we are ready to begin, this procedure is for
BeOS with NetServer; next we will see how to con-
figure BeOS with Boneyard (Zeta, dano, BeOS +
Boneyard).

Once downloaded the PPPoE driver, open the .zip
file that contains three folders: the "bin" folder wich
contains the driver itself, the "src" and "documenta-
tions" which contains, respectively, the source and
the documentation available for the driver both
for PPC and x86.

Installing the driver

Open the bin folder and move the file "ppoe in the
folder /boot/beos/system/add-ons/net-ser-
ver/, then double-clickthe file pppoe and check
both the available boxes (PPPoE Active and Force
Manual DNS).

Resource configuration

Your Ethernet card must be aknowleged by the
system; if there is no driver in the Devices list, then
go to www.bebits.com find a driver for your card
and install it. If the network card has been installed
correctly, opening the networkpreferences you will
find it among the Network Interfaces, then insert-
the Hostname, save and restart the network. Click
on Settings, select Specify settings and insert an IP
address such as 192.168.0.1, a Subnet Mask such as
255.255.255.0 and a Gateway such as 0.0.0.0, then
click on Done and restart the network.

Open the /boot/home/config/settings folder
and double-click the file network, if you had follo-
wed the procedure it will show as in FIGURE 1; edit
this file ( the line PROTOCOLS="pppoe"), save then
restart the network again, form the Deskbar sub-
menu preferences.

This Dossier will help you to install and configure an ADSL connection for BeOS.

Figura 1



Dial-up Networking configuration

From preferences open Dial-UP Networking and
add a new connection cliking on click to add;
insert the user-name and the password given by
our ADSL subscription: the password can be saved
by cliking on save password.
Clicking on Settings, we now insert the PrimaryDNS
and the SecondaryDNS, then restart the system.
After reboot, to connect you just have to click on
Connect in the Dial-Up Networking: if all is right
after a few seconds we will be on-line.

Boneyard configuration under Zeta, Dano and
BeOS 5 + Bone

From the Deskbar sub-menu preferences open
Boneyard, click on the tab Interface: you should
see your card among the devices ( in my case, a
RealTek chip, so it's /dev/net/rt18139/0); click
on Settings, select Addressed and insert manually
IP Address 192.168.0.1, Net Mask 212.216.12.112
and Gateway 212.216.172.62, then save clicking
Done.
Click the tab DIal-Up and in Connect To select
new and after inserting a name click on Add
Service; now select pppoe in PPPType, the device
of the net card in Ether Device, insert User Name
and Password, then click on Apply Changes.
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Click on the "modem" button and configure the
various fields this way: "Modem Port"
/dev/ports/tri_modem; Port Speed 115200; Init
String ATZ and save.
To connect click on the button Connect from Dial-
UP Networking.

Now have a good time!

Figure 2

Boneyard is the unified configuration
panel of BONE (BeOS Networking
Environment).

Browse the web with BeOS and ADSL



Q
uando ho conosciuto BeOS, leggendo un arti-
colo di Paolo Pisati su un Linux & C. di secon-
da mano, il "fattaccio" era già avvenuto.

BeOS era stato abbandonato dai propri creatori,
venduto a chi non voleva farne niente... GAME
OVER.
Però... ormai la scatola l'avevo aperta, non pote-
vo fare a meno di guardarci dentro. Così, senza
rendermene conto, sempre più spesso la scelta
del sistema operativo all'avvio del computer mi
portava ad osservare sette icone viola accender-
si in sequenza. In poco tempo avevo già cono-
sciuto tutti i siti che parlavano di BeOS, conoscevo
a memoria tutte le applicazioni di bebits, non ini-
ziavo a lavorare se prima non avevo dato un'oc-
chiata alle ultime notizie su The Beos Journal.
Ma il futuro non sembrava roseo. La mancanza di
sviluppo del sistema operativo cominciava a farsi
sentire, il senso di abbandono della comunità
beossiana era palpabile nei vari forum che incon-
travo. C'erano alcuni progetti di creazione di un
nuovo sistema opera-
tivo più o meno simile
a BeOS, c'era sopra-
tutto openbeos, in cui
sono confluite le
migliori menti informa-
tiche del mondo
beossiano al fine di
"ricreare la R5, per poi
estenderla". Il proget-
to sembra forte, bene
impostato e molto
probabilmente desti-
nato al successo, ma

la realizzazione di qualcosa di utilizzabile non pare-
va essere certo prossima.
In un piccolo sito tedesco, yellowtab.de, un'azien-
da dichiarava di voler creare una nuova versione
commerciale di BeOS. Io ero nuovo di quel
mondo, non conoscevo persone, fatti, retroscena.
Quel sito finiva praticamente con la Home Page e
per mesi non l'ho più cercato. 
Verso la fine del 2002 yellowtab.de era diventato
yellowtab.com ed annunciava al mondo di essere
prossima al rilascio sul mercato di una nuova ver-
sione di BeOS. Non qualcosa che si inspirasse all'o-
riginale, ma la vera R6, acquistata ancora grezza
da Bernd Kontz direttamente dalla Be, Inc. prima
che tutto il resto fosse venduto alla Palm.

Era nata Zeta.

Improvvisamente il mondo di BeOS ha ripreso vita,
il forum della YT è diventato presto un punto di rife-
rimento per tutti e Bernd si è trovato migliaia di

volte davanti alla solita
domanda: "Quando
sarà pronta?". Ma se
una risposta precisa
sulla data di uscita non
l'abbiamo ancora
avuta, siamo riusciti
almeno in parte a sco-
prirecosa aspettarsi da
Zeta. Innanzitutto un
migliorato network,
quel BONE solo assa-
porato nella leggen-
daria DANO, ma
anche nuovi print_kit,
media_kit, app_server,
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by daf [daf73@interfree.it]

From Be to Zeta
Zeta is the successor of BeOS and YellowTab is the heir to Be
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nuovi drivers per allargare l'ormai
ristretto parco hardware, migliorato
supporto per le sempre più diffuse
periferiche USB e una piena localiz-
zazione del sistema operativo (fon-
damentale per noi che cerchiamo
di diffonderne l'uso in paesi non
anglofoni), oltre a nuove applica-
zioni sia nell'ambito dell'uso quoti-
diano (multimedia, ufficio, client
p2p...) che in quello dello sviluppo,
con moderni IDE e tool di sviluppo
visuali.

Adesso, a qualche mese di distanza
da quell'annuncio, l'attesa sembra
volgere alla fine e chiari segnali arri-
vano dalla Germania ad indicare il prossimo
autunno come la fine del tunnel per tutti gli aman-
ti del multimediaOS. Nel frattempo abbiamo
ingannato l'attesa guardando i video delle varie
presentazioni che Bernd ha fatto a giro per il
mondo e nessuno dei presenti potrà dimenticare
la magica serata di Padova quando, durante il
webb.it 2003, il simpatico teutonico ha dato vita
ad un vero e proprio show, sottolineato dagli
applausi del folto pubblico, composto in maggior
parte da esperti di Linux e BSD.
Ma lo spirito di BeOS e della sua comunità è sempre
stato rivolto ad innovare, cercando di costruire il
futuro piuttosto che adattarsi al presente. Così non
è ancora uscita Zeta che è già il momento di inter-
rogarsi sul dopo. Il team di openbeos potrebbe non
essere così
lontano dal
r e a l i z z a r e
qualcosa di
grande e la
speranza di
tutti è che le
due anime
dello sviluppo,
opensource e
commerciale,
sappiano al
momento giu-
sto prendersi
a braccetto e
c a m m i n a r e
insieme, per
garantire la
continuità di
quello che,
ad un certo
punto, teme-
vamo di aver
perso per
sempre: il
miglior siste-
ma operativo
possibile, qua-
lunque sarà il
suo nome.    

From Be to Zeta
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by Giuseppe Gargaro [giuseppe.gargaro@tiscali.it]

Prince of Persia
Let’s discover a well-known worldwide classic game.

T
he games realized between the '80s and the
'90s left a mark on us all for the high level of
ideas; today, instead, there is an exhausting

aestethic search and good ideas are very few.
Among the unforgottable games shines "Prince of
Persia", realized in 1989 by Jordan Mechner.
At the time was common for a
developer do everything by
him/herself, so Jordan developed
the game and the graphic, while
the rest was completed by his
family: his father composed the
music and his brother acted for the
study of the prince's movements.
Jordan Mechner is born in New York
and his passion for computers was
born when he was at high school,
thanks to an Apple II.
He has produced some titles for the
Broderbund Software, among them
Karateka (an action/strategy
game that has been a great suc-
cess with its 500.000 copies sold)
and Prince of Persia (about
2.000.000 copies sold) that won
many awards and gained the favor of the critics
thanks to the animation in first place.
The game came out first for Apple II and then for
all the other major platforms: DOS, Macintosh,
Amiga, NES, SNES, Sega Genesis, Commodore
64, etc.
Prince of Persia was a very innovative game intro-
ducing the health bar, when most games were
based on making the higher score possible.
Also, was the first game that used the "rotoscoped
animation", succeding in the reproductioon of
human-like movements.
To realize such study on movements, the first thing
Jordan made was to film his brother with his came-
ra while he jumped and made every movement

needed for the prince; then, using a new machine
made by an english company, made a drawing
from each frame and recorded them on is Apple
II: once on the computer the frames were modi-
fied to look like the prince and in doing so Jordan
succeded in obtaining a smoothness in the move-

ment unbelievable for the time.

The game has a solid story, some-
thing uncommon for the times: the
Sultan is far away at war, and
during his leave the Grand Vizier
Jaffar is in charge ruling the people
with tiranny; you (the prince) are
the only obstacle between Jaffar
and the throne, because you are a
bold young adventurer and the
only daughter of the Sultan is in love
with you... so you are in trouble big
time, and Jaffar throws you in the
pits, closing the the princess in the
Palace's tower, leaving her an hour
to decide to marry him or to die
(not an easy choice, isn't it?).
But you are so good that after win-

ning over a thousand tricks and duels with the pits
guards, you'll find on a bridge over an abyss, wit
that bad guy Jaffar behind you... obviously, after a
bloody duel yuo'll cut him in thiny slices... but the
Sultan has no will to give you his beautiful daugh-
ter in marriage, 'cause your blood is not blue
enough, if not for his daughter that persuade him
he will have your head cut!
So, do they live happily ever after?
Don't think so.
One morning entering the throne room you will see
someone else at the princess side, that will not
recognize you (lovely, isn't she?), and when his
father give his guards the order to catch you, you'll
find throwing yourself through the window to esca-

Nella foto al centro Jordan Mechner, nella foto a
sinistra lo schermo iniziale del gioco originale
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pe, and so begin "Prince of Persia 2".
Prince of Persia has a graphic that though
simple can give you the feeling of the swash-
buckling atmosphere, capturing the gamer
in the lone hero role, against tricks and hid-
den mechanisms, ready to defend from sci-
mitars and skeletons.
The game plays alternatively and wisely bet-
ween action and reflection, and the result is an
arcade adventure tha you can fully enjoy both
during the fightings with swords and the exploring
of the daedalus of tricks and shocking surprises,
that succed in transmitting the pathos that prece-
des a jump or the flowing of the
time needed to save our loved one.
Prince of persia, though it is so pla-
yable, is enough hard given the litt-
le time available to save the prin-
cess and the difficult of the jumps.
The game has had three sequels,
the first is "Prince of Persia 2: the sha-
dow and the flame"(1993), the
second is "Prince of Persia 3D"
(1999), and the third is "Prince of
Persia: the sands of time" (on PS2).
If you have never played at "Prince
of Persia" you have lost a lot, but
you can always make up for the
time lost :)!                                                

L
et's see how re-live the adventure thanks to the
emulators. Without doubt one of the best graphi-
cal versions of the game is the one for the SEGA

Megadrive (Genesis) consolle, follwed by the the
Super-Nintendo, Macintosh and PC versions.
Following are some of the emulator you can use to
play at Prince of Persia:

Gens (Sega Megadrive emulator for BeOS)
www.dawnofthegames.com/downloads/gens2.12a
_bin.zip

DGen/SDL (Sega megadrive emulator for Linux,
BeOS) 
www.pknet.com/~joe/dgen-sdl.html
requires SDL (Simple DirectMedia Layer) libraries

Generator (Sega Megadrive emulator for MacOS)
www.bannister.org/software/generator.htm

AmiGenerator (Sega Megadrive emulator for
AmigaPPC)
www.amidog.com/emu/amigenerator/

DOSBox (("PC x86" emulator for Morphos, Amiga68k,
Linux and BeOS)
dosbox.sourceforge.net/download.php?main=1
requires SDL (Simple DirectMedia Layer) libraries

Let's emulate it!

Alcuni screens-
hots presi da lle

versioni per
Genesis e altri

sistemi

Genesis/Megadrive
Stéphane Akhoun and Caz ported Gens on
Linux, a good Genesis emulator.
http://gens.consolemul.com/
New version of DGen/SDL 1.23 for BeOS 
http://www.dawnofthegames.com/down-
loads/dgen-1.23_x86.pkg.zip

NeoGeo
Edge has ported GnGeo, avery advanced
NeoGeo emulator
http://www.dawnofthegames.com/down-
loads/gngeo-0.5.9a_x86.pkg.zip

Gameboy
KiGB has been updated, it is a good emulator
compatible with OS 9 and OS X.
http://www.bannister.org/software/kigb.htm

Apple][
New Apple II emulator (Virtual ][) for Mac.
http://www.xs4all.nl/~gp/VirtualII/

EMUNEWS
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by Giuseppe Gargaro [giuseppe.gargaro@tiscali.it]

MSX. 8-bit genius
MSX was one of the most powerful 8-bit home computers ever projected. It was a pity that it had

no lucky at all. Let’s discover how to emulate it on our systems

T
he MSX platform (Microsoft Extended Basic)
was born in 1983 from a consortium of japane-
se companies specialized in microelectronics

that wanted to create a new standard.
Following the specs of this standard were build
some ten computers (from Sharp, Nec, Sony,
Hitachi, Toshiba, Mitsubishi, Canon, JVC, etc.) with
the same hardware resources and all compatible
with each other.
The weak point in this idea that could have
been made a revolution in the computer field
was the software: in fact these companies
distributed the hardware everywhere hoping
in applications development, but things didn't
went as they hoped both in the european and
U.S. markets where applications were usaually
made by bad conversion of software written for
other machines at 8bit like the Spectrum. MSX
machines had a Z80A processor, at 8bit and 64 kb
of RAM and were all compatible with MSX Basic.
This 8bit computer had a good distribution and suc-
cess in Japan, thanks to the games created by
themythical Konami; in Europe there was a good
distribution only in Germany, Spain and the
Netherlands.
One MSX that had a good success in Italy and in
the rest of Europe was the Phillips VG8020 (Z80 at
3,6 mhz, 80 kb RAM, 256x192 pixels with 16 colours). 
MSX had an heir that was the MSX2, a very valid
machine which is still mantained by some develo-
pers.  

www.msx.org
www.nic.funet.fi/pub/msx/
www.xydirect.com/msx/

The Philips VG8020

In clockwise sense from
top: Goonies, King’s
Valley 2, Abadia del
Crimen, Athletic Land
and Metal Gear

Athletic Land (1984 Konami) a simple and fun
game where the main character is a child that
will done anything to have fun.
Goonies (1986 Konami) where you have to free
all the imprisoned kids.
Abadia del Crimen (Color Remake for MSX2 2000
Opera Soft) a great classic in 16 bit colours.
King's Valley 2 (1988 Konami) my favourite one :)
Metal Gear (1987 Konami) one of the best
games for MSX.

CHECK IT OUT

Amiga
fMSX students.silab.dsi.unimi.it/~cs390447/afmsx.html
AmiMSX www.arrakis.es/~joanant/amsx.html

Mac OS
fmsx, freeM and Zodiac emulation.net/msx/

LInux
fMS fms.komkon.org/fMSX/
OpenMSX openmsx.sourceforge.net/

FreeBSD
fMSX
www.FreeBSD.org/cgi/cvsweb.cgi/ports/emulators/fmsx

BeOS
About emulation of MSX under BeOS use fMSX/SDL: it
requires the SDL libraries, and is provided of an inerface to
launch the games, fMSXLauncher.
To better control the emulator I suggest the use of scrip-
ting to launch the games: an example to launch Abadia
del Crimen
(Color remake for MSX2) will follow; the commands that
you could use are explained in the readme.txt that
comes with the emulator (to use a rom take away the
command "-disk a" from the script).
#!/bin/sh
cd /boot/emulazione/fmsx-sdl/
fmsx -filter 3 -msx2+ -diska /boot/emulazio-
ne/msx_giochi/abadia.dsk

fMSX
beemulated3.bei.t-online.de/fmsx-sdl-2.6.0.40beos.zip

SDL
diana2.bei.t-online.de/SDLGameLibs.zip

EMULATORS
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by Davide Gessi [davidegessi@tin.it]

REBOL - part I
Scripting language or a distributed application framework?

My first approach to programming took place about twenty years ago, when I was happened by
chance to read a magazine which described how to assemble a board with a microprocessor
that was sold in scatola di montaggio, the language used was 6502 assembly (the future core of
the VIC20). When I understood the first example (it was not so difficult indeed, just the sum of two
bytes…), a fantastic world opened in front of me, hexadecimal opcodes took the place of the
Lego.
Afterwards I was always involved with computer science as a hobby at first, then due to my stu-
dies and finally as a job; that's a long time ago so I had the chance to use many platform to deve-
lop with; three languages made me live again the elation of the first addition: the Prolog at first,
the Smalltalk and nowadays the Rebol.

R
ebol is an interpreted language created and
developed by Carl Sassenrath, one of the deve-
loper of AMIGA and now founder of Rebol

Technologies (http://www.rebol.com).
Rebol is a multiplatform language, it runs on about
forty operating systems, from Linux to Amiga, passing
by Solaris, MacOS, Windows and last but not least
BeOS; even though it is a lightweight language, it
does not require any external library to work. It shines
for its simplicity and formal elegance so It is possible
to develop quite complex applications by writing a
very few lines.
One of its relevant features is the native support for
various internet protocols (such as http, ftp, dns) so
this allows to develop distributed applications, client-
server systems, peer2peer messengers ina very natu-
ral fashion without using obscure and complex proto-
cols.
This aims to be the first of a series of articles dedica-
ted to Rebol programming, we will approach this lan-
guage by bringing out his features, yet looking at its
limits.

INSTALLATION

Installation is very easy and troubleness. Once you
downloaded the software from Rebol site
(ht tp ://www.rebol .com/downloads/v iew-
pro052.tar.gz for Intel and
h t tp : / /www. rebo l .com/down loads/v iew-
pro051.tar.gz for PPC), you have to unpack it in a
temporary folder and launch the rebol executa-
ble.
You will be asked to insert the folder where you
want to install rebol (/boot/apps/rebol is a good
choice), user name, pop3 and smtp servers and
finally the proxy server we use to connecto to the
internet. Once you saved the settings you are
ready to start! I suggest to create a symlink to the
rebol executable in /bin, just type from the bash:

ln -s /boot/apps/rebol/rebol /bin/rebol

followed by 

chmod 744 /bin/rebol

or by dragging the rebol executable in /bin with the
right mouse button and creating a link, then set the
executable permission with the Tracker.

THE CONSOLE

The version of Rebol we have downloaded is called
"View" that, unlike the "Core" version, comes with a
graphic library that allows to create interfaces, but-
tons, text boxes and other widgets; because we
want to fill BeBits with our new utilities and applica-
tions this is the right version!
Start Terminal and type "rebol", View version starts
showing the Desktop, with a set of icons on the left e
in the center some informations about the version of
the interpreter (see FIG. 1). For our first experiments
with this new toy we must unwillingly leave the desk-
top by clicking the console icon on the left, we'll
return to the terminal where the rebol console waits
for us with the prompt ">>".

If we write something like:

view layout [text "hello world!" button 
"Close" [unview]]

the just installed interpreter will emit its first cry.

THE LANGUAGE AT A GLANCE

I just don't want to replicate the tutorials that could
be found on the Rebol site that I recommend to exa-
mine thoroughly various points we will discuss, any-
way I would underline the characteristic of the lan-
guage to excite the curiosity of my attentive readers.
Every example can be copied and pasted directly
to the console for an immediate test.
Rebol is essentially syntax-less, there are not line
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ending characters, the words are separated by spa-
ces and the blocks are delimited by square brackets,
there's no distinction among code and data code.
The assignment of values to a variable can be done
using a colon ":", as of the following examples:

a: 123
name: "davide"
email: davidegessi@tin.it
site: http://www.bebits.com
fruit: ["apples" "pear" "bananas" "oranges"]
current-time: now/time

Even though there is not an explicit declaration of
variable type, this language is strictly typified, many
datatypes exist other than the standard ones (inte-
ger, decimal, string) we could find "email", "url",
"pair" type and so on…
I would like to linger on the last assignment where
the function "now" is called, "/time" is called a "refi-
nement" of the function, in this case allows to spe-
cify we want only the time without the date.

Refinements are very often used in Rebol, an easy
to understand and to remember concept… they
allow to specify more parameters to the functions
or to modify their standard behaviour. Almost all the
functions allow refinements, such as the "request"
instuction that shows a dialog box with three but-
tons by default ("yes", "no" and "cancel"). The next
example user's choice is stored in the variable
"save":

save: request "Do you want to save the file ?"

it is possible to specify the refinement "/confirm" in
order to obtain a mask with only two buttons:

save: request/confirm "Do you want to

save the file ?"

in the case that a refinement needs a parameter it
can be added after the instruction.
A short description is available for every instruction

and its parameters through the "help"
or "?" instructions:

help now

help request

LOCAL AND REMOTE FILES

Read and write are basic input/output
instructions that work with files. Unlike
other languages like C++ or Visual Basic
(where a reading/writing stream must
be opened first, transfer data and close
the stream) in Rebol things are simpler,
to read a local file using the following
instructions:

txt: read %file.txt

im: read/binary %image.jpg

The first line read the entire file and puts i tinto the txt
variable, the second reads an image for which it is
needed the binary refinement. The % means a file
type in the Rebol syntax.
The write instruction needs two parameters, the first is
the destination and the second the data to be writ-
ten:

write/append %log.txt now/precise ;append the
current time to the log file

write %copy.txt read %file.txt ;copy the file

The semicolon character ";" is used to insert remarks in
the code, every character between the semicolon
and the end of the line will be ignored.
I would like to make you notice that the second
example not only copies a text file, but converts line
ending character according to the current platform,
how many times you happened to open a Windows
Notepad file with StyledEdit and to see a little square
at the end of each line?
The problem is easily solved...

Reading or writing remote files is similarly easy, we
must specify an "url" type instead of "file" parameter:

home-page: read http://www.bebits.com ;reading
of the BeBits homepage

messages:read nntp://news.tin.it/it.comp.lang

;download messages from the Newsgroup

Once got the homepage of Bebits it's possibile send
it by mail via the "send" instruction:

send marco@test.it home-page

Oppure è possibile stampare tutti i titoli dei post del
news group come spiegato in TABELLA 1.

FIGURA1 REBOL - part I
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view center-face layout [
style tx label 100x24 right
across
tx "Categoria:" 
cat: choice 196x24 "Suggestions/ideas" "Bug report" "Comments"
return
tx "Description:" 
desc: area wrap 400x72
return
pad 106
button "Send" [

out: rejoin [
"Beyond feedback: " cat/text newline newline desc/text

]
alert either not error? try [send davidegessi@tin.it out][

unview
"Email sent, thanks!"

][
"Error while sending mailare you connected?"

]
]
button "Cancel" [unview]

]
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REBOL - part I

CONCLUSIONS

This was the first taste of Rebol, I leave you with your
new development tool and some demos (see TABLE
2).

Send any comments, ideas and criticism through the
script which generates a feedback module (see TABLE
3).                                                                

forall messages [
for every message
;parse the message retrieving the subject
parse messages/1 [thru "Subject: " copy e to newline]
;print the index of the message and the subject
print reduce [index? messaggi tab e]

]

TABLE 1

TABLE 2

TABLE 3

view layout [
backdrop black 
across h1 red "Some demos for " 
image http://www.itbug.org/images/topics/beos.gif 
return below 
button "Gel" [do http://www.rebol.com/view/demos/gel.r]
button "Mines" [do http://www.rebol.com/view/demos/mines.r]
button "Rebtris" [do http://www.rebol.com/view/demos/rebtris.r]

]
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by Marco Begliardo [marco@marcobegliardo.com] 

BeShare is the world famous file-sharing network for BeOS. Now available for Windows

D
on’t want to miss the chance to share your
files and to chat even when you work with
Windows Operating Systems?  The solution is:

Ozone.
Ozone (http://www.ozone-o3.net) is a BeShare
client (file-sharing and chat networking system for
BeOS users) developed by Vitaliy Mikitchenko and
released as freeware.
Installation requires a few seconds, then an icon
with an (Ozone?) molecule  appears on the desk-
top.
As soon as you launch the program, the main win-
dow appears, with a look very similar to the BeOS
version: on the top there is the list of servers, the
widget for the choice of your nickname and the
status; below we find the main window that shows
the messages from the server and from the con-
nected users; on the left we find the list of users
and on the bottom of the screen a string gadget
where to write.
In order to connect just choose the server from the
list (i.e. beshare.tycomsystems.com), set your
nickname and choose Connect from File menu.
The interface, like its cousin BeShare, is very intuiti-
ve and very easy to understand; typing in the pro-
per widget it is possible to chat publicly with other

users, by clicking on a user name with the right
mouse button you can enter the private chat
mode and to obtain the list of user’s shared files:
from the search window you can choose the files
to download which will be added to the “File
transfers” window.
If you want to globally search a file, just select
File>Search and type the name of the file; to
share your files copy them into the window that
will appear by selecting Open shared folder from
the File menu.
Notice the [Freeware] writing on every window, a
remainder from the author. To personalize the set-
tings just select the Edit->Preferences manu: you
can configure the autologin mode, the colors of
the messages, etc. the "Style" panel allows to
change the look and feel of the windows:
Windows, SGI, Motif...
The official sites announces that Ozone 2 is under
development (new screenshots are added evry
day) and invites you to contribute to the hardwa-
re list of Vitaliy Mikitchenko!                                         

Ozone client in action
while downloading

some files

OZONE the BeShare
client for Windows
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di daf [daf73@interfree.it]

Summer games
Great classics, puzzle, platform and 3D games. As the summer ends we have no excuses, it’s

time to play! 

T
he world of videogames mostly
felt the need for great software
houses, able to invest in research

and development.
To write an application to catalog
one's mp3 files or to connect to ICQ

could be a pleasant exercise, to spent some time
developing on BeOS, but to create a game from
scratch, a real game, one that make you stay
awake all night to search for the truth, it's a task
that only a full-time team of many dedicated
people could face.
It is not by chance that the best games under
BeOS to these days are those that Wildcard
Design had succesfully managed to port under
the platform.
One of the beautiful things about the work of
John Fehrè software house is that the ports were
not a mere version capable of running under
BeOS, but real adaptations that use the unique
characteristics of the system,
to better the game, from the
choice of the workspace in
which to launch the game, to
the readmes using attibutes
to make the simple text more
readable, while an image of
the BeOS filesystem were
mounted on the fly to contain
all the data needed for the
play.
The most famous game that
WD has ported is, without
doubt, Civilization: Call to
Power while the masterpiece-to-be, Worms
Armageddon, never saw the light, because the
brave software house had to fall under the hard
law of the market.
It's a similar situation that's happened in the linux
world with LokiGames that ported many famous
titles to the platform before having to retire.
Does this means that the only O.S. that will see
native games will forever be Windows?
The answer is no, and it comes straight from the
same softwarehouses, that have begun to produ-
ce linux versions of the same titles. 
And we are not talking card games... we talk
about titles such as NeverWinter Nights by Atari
and Enemy Territory by Activision.
3D pixels to the max!
Understanding how this is a preferable road let's
make a simple example: 3D Realms in april relea-
sed the old code of Duke Nuken 3D. After 4 (four!)

days it were compiled the linux version and the
next week we could download our version from
BeBits... 
How much time has 3D lost, when it could have
been ported at zero costs in a time was still
actual?
To persuade the great software houses to look at
our platform with interest again we need two
things: a company/association that will quaran-
tee a constant developemnt and 3D hardware
acceleration.

Obviously, this task is on
the hands of

Zeta/OBOS... and I think those are very good
hands.
O.K., let's leave the past and right to the future.
Now what?
What we can do, between seeing a movie, a ses-
sion of development, and an hour of besharing?
A good help comes, as often does, from the
open-source world.
The presence on our platform of Perl, Python, SDL
libraries (apart from native C++) has let us to



21

G
A

M
ES

compile on BeOS many of the games created by
the enthusiastic people of the free code.
If the entertaining Rollemup and LBreakout, ano-
ther (perhaps the best) re-implementation of the
classic breaking-walls ball, are nowadays classics
of the good time on BeOS, new games appears
often on BeBits.
In fact, it's recently come out KrystalDrop, inspi-
red by the arcade Magical Drop, with a good
soundtrack and a pleasant graphic.
Personally, I spent some ours to win my brother's
record inthe high speed Kobo DeLuxe.
But alas, every time I destroyed an hord of aste-
roids-explosive balls-enemy spaceships I found
tha t my brother was three or four stages up...
perhaps ten years difference counts?                    

PLAYING WITH TUX

Todays informatics that were young in the '80s, they couldn't
have forgotten the sci-fi movie "Tron" by Walt Disney, that it's

quite rarely reharsed by the italian TV.
The adventures of
the characters had
inspired many video-
games, but the
advent of 3D brings
us just in the middle
of the action!

Different open-source projects were born, but two of them
had captured my attention: Armagetron and GlTron.
Bring a Linux-Box (or a Mac, for the matter) with a decent
video-card and go, download and... at the next junction
don't give way to who comes from the right ;)

Summer games
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by Mattia Tristo [mattia_tristo@libero.it]

Our brave Mattia Tristo and Andrea Bernardi
went to Udine to be at an italian Amiga-users
meeting... and more.

Adventure in Udine
AMIGA Alpe Adria 2003

S
aturday, june 5 2003, we
have arrived in the friendly
city of Udine, looking for

the offices of Cloanto.
Cloanto is the software house
that created the famous
Amiga word processor Text
Craft; yes, that one!
Following the instructions from
Cloanto's website, it wasn't
hard to find the way and so we
were at our boot with two PCs,
ready to show BeOS capabili-
ties.
Just after we fired up our
machines, many visitors came
to our place, curious about the
multi-media characteristics of
the OS, which we were sho-
wing playng many compres-
sed videos at once, and simul-
taneously playng some mp3
remakes by the SID of the glo-
rious C64, very good for the
event and the public.
Time was passing by very fast
and, between the demonstra-
tion, we tried to take some
time to admire the new Amiga
OS 4.0 on a PPC A4000 hard-
ware and the AmigaOne, the
MorphOS on hardware
PowerPC Pegasos and the re-
configurable system C-One
(Commodore 64 and other 8
bit computers compatible).
So the morning passed, with
the beutiful presentation by
Jurgen Schober of AmigaOS.
In the first half of the afternoon
it was our turn, but, due to to
organizational needs regar-
ding the other presentation,
the time at our disposition had
been reduced to 35-40 minu-
tes; after we began people
showed a great interest and

Dall’alto Mattia e Andrea, Jens Schönfeld pre-
senta il C-One, un nutrito gruppo di curiosi e in
basso un Amiga PPC e due motherboard
AmigaOne. Nella pagina accanto: ancora
Mattia e Andrea che presentano la distribuzione
BeOS++ di Ken, Linux su hardware AmigaOne e
un momento della presentazione di AmigaOS
4.0.
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Amiga Alpe Adria 2003

the short descriptions and the demonstration
played on a big screen of the speed and multi-
tasking and multi-threading capabilities of the
platform, had a great success.
We showed the speed of the OS booting in less
than ten seconds and shutting down in even less,
and how easy is to install both a distribution and
the applications, being the latest operation a
simple matter of copying files.
We showed also the stability of the system, how
with an actual application crash, and even a
desktop one, one can continue to work with the
other applications, and how with a few steps
one can return again 100% operative, without re-
booting the system.
The real proof of the success that BeOS met
came at the end of the presentation, when peo-
ple begun to ask.
Happy to answer, we demonstrated more and
more of the practical characteristics of the OS,
we talked about past, present and future of
BeOS, underlining the fact that with the coming
out (soon) of YellowTab Zeta and the ongoing
development of OpenBeOS we will see many
better features and innovations, making this OS
more and more fascinating.
Hardware support will be soon enlarged, and we
spoke so much that we used an hour instead of
the 35-40 minutes we should have had at dispo-
sition.
Our opinion, judging by the interest and the
curiosity surrounding this wonderful OS: BeOS
and its heir Zeta are a clear answer to the actual
needs of a PC user, such as speed (booting,
shut-down, execution), stability, multi-media fea-
tures, easyness of installation, use and mantai-
nance.
We are sure that Zeta and OpenBeOS, in the
future, will met all the needs that rise using other
and more well-known OSes, which they seem
unable to met, creating unsatisfaction.
An ending note: people were stupified by the
fact that BeOS from the end of 1999 is no more
"officially" supported, and in spite of this is yet
able to create awe and to capture the user's
attention, also being competitive among OSes,
and this is a sign of an organization and internal
structure truly exceptional, a masterpiece of the
geniuses that worked at BeOS, Inc.
Those are not only the words of two BeOS fans,
but the naked truth: seeing is believing
[http://yellowtab.com].
We would like to thank Cloanto to let us take
part in this event [http://cloanto.com].

The published photos were taken by:
Andreas Bornmann

Claudio Marro Filosa
Daniel Beorchia
Jens Schönfeld

For a wide photos report please visit the site:
http://www.cloanto.com/events/aaa/gallery.html
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